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Work Orders 

EnterpriseIQ supports three types of work orders - manual, system generated, and firm. All serve 
important purposes and are discussed at length in this chapter. 

Manual work orders are created, edited and deleted from the Work Order module found on the EIQ 

Launcher Bar. This module can also be used to review system generated work orders. 

Manual work orders are normally used under two circumstances: 

▪ During early implementation when orders and inventories are not accurate enough to generate work 
orders, manual work orders can be created to begin scheduling and RealTime monitoring. 

▪ Although no sales orders or other sources of demand are present in the system, the manufacturing 
team decides to run parts for stock or other special purposes. 

In contrast, system generated work orders take into account the demand for parts and the on hand 
inventories. Generated work orders are, in the simplest form, created when there is a difference 
between the demand (typically sales orders) and the supply (on hand inventory). 

Therefore, a generated work order will contain only enough parts to meet demand. A sales order does 
not necessarily generate a work order, though work orders are usually made up of one or many sales 
orders. 

System generated work orders are created and managed through a special program called Update 
Schedule. This function creates work orders refreshes the material planning data. The function can be 
found within the main scheduling screen, under the File menu option. 

Firm work orders provide a bridge between system generated and manual work orders. Firm work 
orders usually start out as generated work orders, though they can be created manually. Once the 
original work order is created, the quantity to produce can be modified, and the work order can be 
declared a firm work order. 

Work orders become part of the schedule pool automatically but must be manually placed on the 
schedule (unless auto load is used - please see the scheduling chapter), and they must be removed 
manually. 

Work Orders and the BOM 

Work Orders are always based on the Manufacturing Configurations (BOM). Each work order can contain 
multiple items that are manufactured simultaneously (Family Tools). 

Each individual part may carry one or more delivery quantities and delivery dates. Each part may also 
carry a unique order number (internal) and Purchase Order number. 

Work Orders and Material Planning 



Work Orders Page 4 of 66 

 

Material planning is based on the work orders found in the system. Just as Sales Orders create demand 
to manufacture parts, work orders create demand to procure required materials. 

Work Order Types 

Because EnterpriseIQ supports multiple manufacturing types, it must also support various work orders 
based on the type. The work order entry screen will differ slightly depending on the manufacturing type. 
The field listing below is relevant to the majority of manufacturing types. The section below that will 
describe the different fields where applicable. 
 

Top Section of the Work Order Form 

Work Orders 

Select the Work Order button from the EIQ Launcher Bar and choose a Work Order from the pick list. 
Notice that the top level work order will display in bold on the pick list. Below is an example of an generic 
work order. Work orders for other manufacturing types such as injection, blow molding, diecast, and 
stamping will include the same fields. 
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Below is an alphabetical field listing outlining each of the fields contained within this screen. 

Top Portion of Work Order Screen 

Added By User For Manual work orders this will display the user name that created the work order. For 
non-manual work orders this will say ‘PLANNED’. 

Auto Remove If the work order is marked Firm this field will become visible. Users have the option to 
have the system automatically delete completed, non scheduled firm work orders, that are 
not on a non-archived production reports. The global setting is established in Scheduling 
Parameters but can be overridden for an individual work order from this field. The work 
order will automatically be set to the System Default but users can select a Y or N from the 
drop down list in this field to override the default. 

BOM UOM Displays the Unit of Measure from the Bill of Manufacture. 

Bucket Buckets are assigned by EnterpriseIQ to generated work orders. It represents the total 
amount of an item that needs to be manufactured within the Run Size Scope. The total 
bucket amount may consist of items necessary to fulfill multiple orders, but the orders are 
grouped into buckets for the purposes of scheduling one production run. 

Manual work orders will not show a bucket number. 

Work orders are generated in bucket order for users that use the work order number for a 
lot number so the lowest work order number will be first. 

Note: Update schedule will not allow buckets to be scheduled out of sequence.  Update 
Schedule will re-bucket if a user schedules out of sequence manually. 

Center Type Work centers are identified by their "type", just as a BOM is linked to a manufacturing type. 
This field shows the type of work center that will be used when the job is scheduled. 

Components Based 
On 

This field will display BOM unless the components have been hard allocated. If material has 
been allocated, deleted, or added it will display 'Hard Allocation'.  

Customer Displays the Customer associated with the work order. 

Cycle (Sec.) This field shows the time, measured in seconds, from the start of one shot to the start of 
the next shot. 

Cycles Planned Cycles Planned is information only.  It will only be locked in at the time the work order is 
made firm otherwise it is a copy of work order Cycles Req. For planned and forecast work 
orders, this value is the original count at the time the WO is created.  For manual work 
orders, this value populates when it has been marked firm, and is taken from the cycles 
required field (WORK ORDER.CYCLES_REQ). 

This value will be locked for Firm work orders only. If the work order is Firmed and running 
in the first position of the finite schedule, the Cycles Planned will not change, it is locked 
into the value it had at the time the work order was Firmed.   

The value will change for non-firm planned work orders as the requirements change. 
However, when a work order is set up in the first position, the RealTime history table 
(HIST_ILLUM_RT) records the cycles planned at the time the work order was set up. This 
number will not change. 

This field is visible in the pick list, the calculation for this field is Cycles Planned * 
Cavitation/Multiplier. 
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Top Portion of Work Order Screen 

Cycles Req. This is the total number of cycles needed to complete this job. This is recalculated every 
time update schedule is run and will only decrease if the work order demand has decreased 
(as in the sales order release being changed downward), or the inventory on hand has 
increased. The Cycles Req. can actually increase if the demand has increased as long as the 
work order has not been firmed.  Even if the work order is firm it will still decrease as 
inventory increases when update schedule is run. 

Cycles Req will change each time update schedule is run even if the work order has been 
firmed.  Cycles Req is determined by (demand – the on hand inventory). 

Date Created The date the work order was created based on the system date. 

Description The description of the work center the work order is scheduled on. The description of the 
work center can be displayed by selecting the + next to the Scheduled On field. 

Division ID This is the division/warehouse associated with the Auto-MRP demand if applicable. 

End Date This is the last Delivery Date from the Deliveries Quantities section of the work order. 
Depending upon if there are Move Days for this item this may be the same as the must ship 
date. 

EPlant Displays the EPlant associated with this work order. 

FG Lot # The user can change the finished good lot number by clicking on the icon next to this field 
and entering the new lot number. 

If the work order is marked Firm an additional check box will display on the Set FG Lot # 
form, 'Retain Assigned Lot # for this Work Order'. When this option is checked the system 
will populate the FG Lot # in the Work Order table (WORKORDER.FG_LOTNO), and the lot 
number that is assigned will not be changed by the system later with the work order 
number if the global Scheduling Parameter 'Use WO # as Lot #' is checked.   

Firm WO Check this box to mark a work order firm. 

Note: You cannot just un-check the firm box if you no longer want the work order to be 
firm. If it is un-checked it will become a manual work order. If you no longer want the work 
order marked firm you must delete it and re-run update schedule to properly re-evaluate 
the need for the item(s). If the Firm box is unchecked the user will receive a confirm 
message stating, "Unfirming this Work Order will transform it into a Manual Work Order 
which must then be manually deleted from the system. Demand is NOT allocated to 
Manual Work Orders. Are you sure you want to continue?" Security can be placed on this 
message. 

Please see Creating a Firm Work Order below for more information on Firm Work Orders. 

Group ID This is the Group ID of the work order if applicable. A Group ID can be assigned to work 
orders from the Group ID Assignments form which is accessed from the Finite Scheduling 
module->Options menu. The Group ID will show on the Work Order form and in pick lists 
for Finite Schedule, Scheduling Pool, and Work Orders. (See Group ID Assignments for more 
information). 
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Top Portion of Work Order Screen 

Labor This is the Labor from the BOM. Click on the ellipsis button to bring up the labor details 
including the labor code. The information cannot be changed from this form. 

Make To Order # This will display the Make To Order sales order associated to the work order.  

After update schedule is run the system will create work orders for the difference between 
what has been hard allocated to the Make To Order sales order and the releases required 
on the sales order. The demand for Make To Order releases only looks only at the on hand 
inventory allocated to that order detail. MTO Allocated Inventory is ignored during 
allocation to dynamic allocation Sales Orders (non MTO). 

By default, for Make To Order demand, a work order will be limited to only one sales order.  
Multiple hard allocated sales orders will not be combined on a single work order but will 
have separate work orders. However, if the ‘Use SN Labels to Control MTO Dispositions’ is 
checked (System Parameters->Purchase Order and Sales Order Setup tab), MTO releases 
will be combined on work orders rather than getting a work order for each release 
(including multiple customers/orders). All other allocation functions of MTO will remain the 
same, only bucketing is different. (This is designed for use with the Slitting MFG Type). 

Users can also manually assign a Make To Order sales order to a work order. The work 
order must be marked Firm first and the sales order must have releases. To link a sales 
order click on the ellipsis button in the Make To Order # field. A list of Make To Order Sales 
order(s) will appear. Highlight the sales order to link and select OK. 

Manufacturing # Displays the configuration number for this work order. This can be changed by selecting the 
ellipsis button and picking another MFG # from the pick list. Only BOMs that manufacture 
the items on the Work Order (for family tool work orders, BOMs associated with all the 
items on that work order) are listed. If another BOM is not already created that produces 
the item, a substitute BOMs can be created, please see Substitute Mfg # for more 
information. 

If the MFG # selected is a different MFG Type than the original one, a message will appear 
stating, "You are attempting to change the Mfg# of this work order to a different Mfg Type. 
Release(s) will be automatically deleted. Do you wish to proceed?" The user can select Yes 
to continue with the change or No to return to the work order without making any changes. 
This confirm box has a 'Do not show next time' check box that when checked it will prevent 
this message from appearing. Security can be placed on this area. If a BOM for the item is 
chosen that has a different MFG Type the information in the Delivery Quantities section will 
be removed. 

Note: The Manufacturing # cannot be changed for a work order that has allocated material. 
If a user attempts to change it a message will appear stating, 'Work order has allocated 
material, remove allocation to select an alternate manufacturing number.'  

Note: The Manufacturing # cannot be changed for a work order that is scheduled in 
Assembly Track or Assembly Track by Group. An error will appear stating,' WO# xxxx is 
currently running on Assembly Track.  – unable to proceed. Work Order must be removed 
to change Mfg #'. 

Material Displays the associated material used to make this item. 
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Top Portion of Work Order Screen 

Must Start Shows the date that the job must be started or some of the scheduled deliveries may not 
be met. This field is also in the work order pick list to enable sorting by the must start date. 

The must start date is calculated as follows: 

Sales Order Promise Date less the number of ship days based on the calculation for the 
Must Ship Date (see Calculating the  Must Ship Date for more information), adjusted for 
Wait Time, Move Time, and Production Time. The date includes the time it takes to 
complete all requirements in the work order. 

The Production Time = Net cycle time x cycles required. (Net cycle is Cycle/Eff Factor). This 
value is displayed on the work order in the Prod Hrs field. 

The Move Time and Wait Time are values in days that can be set on a specific inventory 
item (manufacturing tab). 

For more information refer to the Must Start Dates section in Generated Work Orders. 

NOTE: For inventory items that have a Mfg Min Qty set the must start date will NOT be 
based on the Mfg Min Qty but the quantity of the original sales order amount. If you have a 
sales order for 1000 pieces and the Mfg Min Qty is set for 5000, the Must Start Date will be 
based on the 1000 pieces, not 5000. 

However; once the work order for an item with a Mfg Min Qty is scheduled in the first 
position it is marked firm and the must start date will be based on the work order quantity 
and not the sales order quantity. (Remember a firm work order is no longer linked to a sales 
order). 
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Top Portion of Work Order Screen 

Must Start 
(Additional 
Information) 

Exceptions: 

The calculation for this date for dependent work orders will depend on whether the feature 
Evaluate Negative Consumption is selected. With this turned on the must start date of 
dependent work orders will be based on the actual start date of the parent work order. If it 
is not turned on, the must start date of dependent work orders will be based on the must 
start date of the parent - not the actual scheduled start date. The Evaluate Negative 
Consumption feature is in Scheduling->Options->Scheduling Parameters/General section. 

The use of overlap hours in Generic BOM’s (Attached Materials->Details tab) will also affect 
the must start date. The must start date on the child work order will be   based on the 
must start date of the Parent work order. The system takes that date and backs up the 
number of overlap hours to come up with a must start date for the child work order. The 
time between the must start date and the end date will no longer be based on the actual 
production hours. However, when the work order is scheduled the actual production hours 
will be reflected in the schedule. 

Note: Overlap hours cannot be used if the start time plus the run time of the child will end 
later than the end time of the parent. This information is kept in the Ptallocate log. 

For Example: 

 

There is overlap on three items. The first item is due 1/21/10 with 114 hours - must start 
date is 1/16/10 6AM. The next item has overlap of 3 hours. The system takes the start time 
of 1/16 6AM and subtracts 3 hours and arrives at 3AM. Then it adds back the production 
hours of 83.33 and checks to make sure that the end time would not be past 1/21/10. 1/16 
6AM + 3.5 days = 1/19 6PM, so overlap is allowed, and the must start is 1/16 3AM. The next 
item also has overlap so the system calculates the must start date of 1/15 11PM (4 hours 
before 1/16 3AM). Then it adds the production hours of 25.66 and checks to make sure that 
the end time would not be past 1/16/10 6AM (The end time of the parent). 1/15 6PM + 
1.10 days = 1/17 00:40 which is later than 1/16 6AM so the overlap hours are not allowed 
to be used. The system uses the full 25.6 hours to arrive at a must start date of 1/15 
4:20AM. The last step has 5 overlap hours, so it calculates 1/15 4:20 AM - 5 hours = 1/14 
11:20PM, then adds the 77 hours. The end time would be 1/18 8:20 which is after 1/16 
3AM, so again overlap is not allowed. This information is written to the PTallocate Log 
("Overlap hours cannot be used - calculated end date ##/##/#### exceeds parent must ship 
date. Must start date was adjusted based on parent must ship date and prod hrs.").  

Origin Indicates where the Work Order was created from. Either from a Sales Order (Planned), the 
Forecast module (Forecast), or Manual. 

Priority A work order can be marked a priority by checking this box. The Priority field in scheduling 
will be marked with a Y and display with a light blue background.  

Auto load will first load priority work orders over non-priority work orders. 
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Top Portion of Work Order Screen 

Priority Level This indicates the work order's priority level. A numeric value can be entered in this field 
and will be visible in the Schedule and RealTime. The level can also be entered from the 
Schedule or RealTime and this field will be updated. Priority Level values are not sequential, 
there can be multiple records with the same level. 

Priority Note This is the priority note associated to the work order. This can be entered on the work 
order, in the schedule, or from RealTime and will be visible in all places. It will also be 
visible from the Dispatch Lists in Assembly Track. 

To enter the note on the work order select the ellipsis button in the field and type the note 
in the pop up box. The note can be up to 50 characters. It may be printed by clicking on the 
Print button. 

Priority Note 2 This is an additional priority note that functions the same as the other one described above. 

Prod Hours The number of calculated production hours required to complete the entire job. 

Note: If a work order has a total run time of less than one second the software will not 
truncate the decimal and round to ensure material exceptions will still appear.  

Project # A Project Manager Task record can be linked to a work order from the work order, or from 
Project Manager. A new manual work order can also be created from Project Manager. 
When linking an existing work order, this option is only available for Firm or Manual work 
orders. Select the ellipsis button in this field and select 'Link Project Task'. A pick list of tasks 
will appear to choose from. Once a task is linked select the 'Jump to Project' option to jump 
to the Project Manager module. Select 'Unlink Project Task' to remove the link. 

When attempting to delete a linked work order directly from the Work Order, a status 
exception message surfaces stating ‘Work order is linked to project’ with security available 
to the OK button. 

Run Hold (Finite 
Schedule) 

If a work order is set as Run Hold then when it gets setup in first position the user receives 
the message, "Work Order # <xxxx> is on a Run Hold - do you want to continue?". The user 
is given the option to select Yes to continue or No to cancel. Security can be  placed on the 
continue option to prevent users from scheduling the work order. 

Scheduled On This field shows the work center that the work order is scheduled to run on along with the 
position (sequence in which the job will be ran). 

This field will only contain data if the work order has been scheduled. 

If it has been scheduled right click and select Jump to Schedule to open the scheduling 
module for the work center where the work order is scheduled. For Assy1 and Assy2 MFG 
type work orders, this option is ‘Jump to Assembly Track’.  

Setup Hours Shows the number of hours required for setup. This information is found in the 
configuration standard (BOM). 

Type If the work order demand came from Auto-MRP this field will say AUTO-MRP otherwise it 
will be blank. 

WO # Internally generated by the system when the work order is created--either manually or by 
running update schedule. 
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Work Order Speed Button Options 

▪ Search - Select the search button to access the work order pick list. 

▪ Toggle Form/List - This toggles the form from Form to List views 

▪ Print Worker Order(s) and Print Routing Packet - Select these speed buttons to print work order(s) or 
the Routing Packet. See the Printing the Work Order section for details. 

▪ Substitute Manufacturing # - Select this button to create a substitute Mfg #. See Substitute Mfg # for 
more information. 

▪ Material Allocation - This speed button accesses the Material Allocation form. See the Hard Allocation 
section for details. 

▪ V.I.N. - This accesses the V.I.N. Generator module. Please refer to the Vehicle Identification Number 
(VIN) Generator https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf TechNote 
for more information. 

▪ Status of 'Print With' Documents -This speed button will launch a grid to show the status of all 
documents that will Print With the work order. The user can select the View Document button or 
double click on the document to view it. 

 

https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf
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▪ RealTime Work Order History - This button opens the RT Work Order History form for the specific 
work order, See RT Work Order History. 

▪ Production Report By Work Order - This opens the Production report by Work Order module. 
Reference the Production Reporting by Work Order section for more information. 

▪ Process Cost by Work Order - This will open the Process Cost form displaying the costing information 
for the item on the work order. See Introduction to Process Costing for details on this module. 

 

▪ EIQ Bookmark - This option allows the user to drag and drop the icon onto the desktop or a folder in 
order to open the exact work order up again with one click. 

Options Menu 

Under the Options menu there are two mutually exclusive options: 

▪ Delete Sub-BOMs on WO Archive - This is the default option. When checked substitute BOMs will be 
deleted when a work order is archived. 

▪ Do Not Delete Sub-BOMs on WO Archive - When this is checked the system will not delete substitute 
BOMs when a work order is archived. 

▪ Release Hard Allocated Material on WO Archive - When this is checked, when a WO is archived, the 
system will release the hard allocation on any remaining material hard allocated to the work order. 
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Non Injection MFG Type Work Orders 

Extrusion Work Orders 

The Extrusion work order screen is very similar to the Injection.The fields are identical to that of an 
Injection work order except the Cycle (Sec) and Cycles Req. fields are replaced with Parts/Hr and Length. 

Parts/Hr This field shows the number of parts that will be produced in an hour. 

Length The number of feet that is required in order to fulfill this order. 

 

Extrusion2 

Cycles Required Calculated as: Work Order Quantity / RT signal rate on BOM 

Lbs/Hr or Kgs/Hr This field shows the number of Lbs/Kgs that will be produced in an hour.  

Lb/Kgs Req The number of Lbs/Kgs/Grams (based on the UOM being used) that are required in order to 
fulfill this order.  

With no scrap or regrind the formula is: Part weight(s) converted to the correct UOM (LBS, 
KG, or GR) 

With scrap and regrind % equal to or greater than the scrap % the formula is: (Part weight 
in UOM) / (1- scrap%) 

If the Regrind % is less than the Scrap % then the formula is: ((Part weight in UOM * WO qty 
in Lbs) / (1- scrap% ) * 1 - Regrind % 

 

Extrusion3 

Lbs/Hr or Kgs/Hr This field shows the number of Lbs/Kgs that will be produced in an hour.  

Parts Req The number of parts required to fulfill the order. 

Generic Work Orders 

Generic work orders are similar to injection work orders with the only difference being that no material 
will be listed in the Material field and the BOM UOM field is not relevant. 

Outsource Work Orders 

The screen for Outsource work orders is similar to injection work orders with the exception of the Cycles 
(Req) field is replaced with Day/K or Days and the Cycles is not applicable. 

Days Shows the number of total days or the number of days per 1000 parts it takes the 
outsource vendor to produce the parts depending on how the BOM was set up. 
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Cycles Req. This field is not applicable to an outsource work order. 

 

Assembly Work Orders 

There is a Stop Production check box that will prevent employees from being able to log into the work 
order in AssemblyData. This allows the scheduling department to put a stop to all work related to a work 
order regardless of where in the factory the order is being processed. If an employee attempts to log in 
to a stopped work order, they will get a message: “Work order xxxxx is stopped for production. Unable 
to login.” Note: This does not prevent a user from Labor Reporting in Assembly Track. To restart the 
production just un-check the Stop Production box. 

 
 

Bottom Section on a Work Order and Work Order 
Right Click Options 

The bottom sections on the work order form contain the same fields regardless of the type of work 
order. 

Configuration Details 

This section displays the inventory item information associated with the Mfg # on the work order. 

Item The inventory item number produced by the Mfg #. 

Description The description of the item number. 

Cav/Multiplier The standard cavity or multiplier for the inventory item. 

Rev The revision level of the inventory item. 
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From this section the user can view the Routing Diagram by clicking on the Routing Diagram speed 

button . This feature brings up a color coded, visual routing diagram of the processes involved to 
make the highlighted item. Each step or required item is displayed as a color coded box. The part 
produced by the work order selected is indicated by a border (blue line) surrounding it in the diagram. 
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From the WO Routing Diagram the user can click on the button in the lower right portion of a blue box to 
jump to the scheduling window which shows related work orders and where they are scheduled. If there 
is not a work order this button will not be visible.  

The progress of each operation scheduled in the first position on a work center connected to RTServer is 
displayed as a blue status bar along the bottom of the box and includes the percent complete. If the 
operation is overrun the status bar will turn red. 

Additionally if there are material exceptions associated to the components a red flag will wave. The 
material constraints are considered for current conditions and the flags wave on all materials that 
currently have a constraint. The user can right click on the item and select ‘Jump to Exception List’ to 
view the material exceptions for the item. (Note the flags will only be visible at zoom levels 3 - 8). 

Print Labels - Select the Print Labels speed button   to print labels for the selected item. The 
system will calculate the correct Labels Quantity based on the selected package and quantity on the 
work order. If a Work Order does not have a customer assigned, when printing a label from the Work 
Order the customer field will be blank.  If the work order has a customer associated to it the labels will 
print with the customer information by default unless the 'Exclude' check box is checked (next to 
Customer field on the print label form). This allows users to print a label with no customer information 
for scenarios when the work order has multiple sources of demand. 

Note: For Label Matrix users, a new Label Matrix label must be created for printing from this module.  
The label may optionally include start_time in the dbf file for printing the WO Must Start date and time 
on the label.  When attempting to print with a pre-existing Label Matrix label the system will surface an 
invalid date message and no record is created in master_label (regardless of start_time included on the 
label). This message will not appear for Crystal labels.  (See Labels for Manufactured Items for label 
information). 

Delivery Quantities 

The Delivery Quantities section displays the release information from the sales order such as quantity 
and delivery dates.  
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▪ Blue Text - If the Scheduling Parameter for 'Combine SO & Forecast Demand on WO' is checked the 
demand coming from the Forecast module will display in blue text. 

▪ Orange highlight - This indicates that additional demand was added by the system. This demand is 
added for various reasons.  

▪ If the Scheduling Parameter for 'Force Bucketing for Mfg Min/Max Quantity' is checked update 
schedule will force multiple sales releases into a single bucket even if they have min or max 
quantities, or 'multiples of'. If additional demand was added by the system due to Mfg Min Qty or 
Multiples Of values the line will be colored orange in the Delivery Quantities section. When 
‘Force Bucketing for Mfg Min/Max Quantity’ is checked and 'Wait Time' is used on the 
manufactured item, the extra quantity added to the work order is not included in the evaluation 
for the Must Start Date of the work order as it could result in the Must Start Date on the work 
order being early.  

▪ Additional demand may also be added when there is a family tool but not all items have actual 
demand.  If there is demand for any of the items in a family tool, the system will generate 
'family demand' for the other family items. For example, if a tool makes two different items and 
only one of them has actual demand, the work order will list both items. The delivery quantity for 
the one that is not on the sales order will be highlighted in orange. This will ensure attached 
material/components are planned for all of the family items.  If cavities are closed for any of the 
family items, material/components will not be planned for the item with zero actual cavities. 

▪ Additional demand may also be due to cavitation. For example, if the Cav/Mult is 2 and the 
demand is for 25, a line will be added by the system for a quantity of 1 and will be highlighted in 
orange. 

▪ Additional demand may be generated due to Cycle Rounding. When the cavity/multiplier is not 
divisible by the quantity required additional demand will be added to work order. For example, if 
the Cav/Multiplier is 3 and the demand is 1000, the system will add additional demand of 2, 
which will be highlighted orange. 
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In all cases the 'Allocation Note' will state: “System added due to family generated demand or cycle 
rounding”. Select the ellipsis button in the Allocation Note field to view the entire note without having to 
enlarge the column. 

Quantity The work order quantity.  

This will display based on the Native unit of measure associated to the EPlant if applicable 
(System Parameters->Enterprise->Miscellaneous tab). Otherwise it will use the Native UOM 
setting on the Regional tab in System Parameters. 

Note: If a manual work order is created with a quantity greater than the Max WO Batch Size 
from the BOM, or if a planned work order is firmed and the quantity is changed to be 
greater then the Max WO Batch Size a status exception will appear stating 'Max WO Batch 
Size Exceeded'. It will include the WO #, BOM#, WO quantity and Max WO Batch Size. The 
form includes OK and Cancel buttons. Security can be placed on the OK button. For family 
tools, if any item exceeds the BOM Max WO Batch size, the status exception will surface. 

Delivery Date The date the product must be delivered to meet the promise date on the sales order. This is 
the promise date less the ship days associated with the ship to address on the sales order 
and the Wait Time on the Inventory record. 

Order # The sales order number associated with the quantity. 

PO # The customer’s purchase order number associated with the quantity and sales order. 

PTAllocate ID This is the internal ID given to the work order during the update schedule process. This is a 
system generated field used to determine demand and cannot be modified. 

Division This field will populate with the division/warehouse linked to the ship to address on the 
associated sales order. The Division only populates from the SO header and not from SO 
releases. 

This is informational only. 

Ship To The Ship To address associated with the release on the sales order. If the Release ship to 
field is null this will be populated with the Ship To address associated to the sales order. 
Mouse over the field to see the detailed address information in a pop up hint. 

For Manual work order, a Ship To address can be selected from the drop down list which is 
based on the customer associated to the work order. 

WO Note This will display the WO Note associated to the release line of the sales order. Double click 
on this field to enter a note. A WO Note cannot be created for a manual or firm work order 
since there is not link to a sales order. To view the note, select the ellipsis button in the 
field. The note can be printed by selecting the Print button. 

NOTE: When the Work Order is marked FIRM and update schedule has been run, the 
connection to the Sales Order release is severed and the WO Note will go blank.   

Job Sequence This is an EDI field that supports shipment sequencing. This value comes from the Sales 
Order-> Release section. 

A value can be manually typed in the Job Sequence field in Sales Orders but not in Work 
Orders. This field is also visible on the Assembly Track Dispatch List form and the 
Unscheduled Process grid, the Assembly Track Dispatch List Priority, and in the Assembly 
Track Sales Orders grid.  
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Allocation Note If there is system added demand the line will be highlighted in orange and a note will 
display in this field stating: “System added due to family generated demand or cycle 
rounding”. 

Refer to the "Orange highlight" section above for more information. 

Note: If a user attempts to edit the delivery quantities and dates on a planned work order while update 
schedule is running a confirm pop up message with a Yes and No button will display stating, 'Editing this 
planned work order while the MRP engine is processing can affect allocation and generate duplicate 
demand. Continue?'.  If the user selects Yes the changes will be made to the work order, if No is 
selected the changes are not made. Security can be placed on the Yes button. 

Right Click Options 

The user can do the following by right clicking in the Configuration section: 

▪ BOM Tree - This displays the BOM Tree showing all the requirements to create the item in the native 
unit of measure. 

 

▪ WO Inventory transactions - This displays the transaction log for the highlighted item for disposition 
transactions associated with the work order. 
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▪ Jump to BOM, Inventory, Transactions/Locations, Sales Orders, and Inventory Availability - These 
‘jumps’ will take you to the selected module for the highlighted item. 

▪ Jump to Forecasts - If the Origin of the work order is Forecast this jump will be available. It will open 
the Forecast module to the corresponding forecast record. 

▪ Gantt Chart - This brings up a Gantt chart for the item which can be viewed in chart or tabular 
formats. 

 

▪ Work Order Information - This option opens the WO Routing Diagram, which can also be accessed 
from the Routing Diagram speed button mentioned above. 

▪ View sales order allocation - This will display the sales order allocation. Users can right click to jump to 
the sales order from this form. 
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Printing the Work Order 

To print a work order the user can select the Printer icon at the top of the work order. A screen will 
appear from which the user can enter in the from and to work order number(s) to be printed. This 
information defaults to the current work order displayed.  
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▪ Exclude attached documents - Select this option to not print any attached documents that are set to 
print with work order. 

▪ Print Labels - When this box is checked, in addition to printing the work order and any 'print with' 
documents, the system will also print the correct number of labels. The label print dialog box will not 
open. The system will calculate the label quantity based on the quantity on the work order for the 
default label and quantity per package.  For family tools, the labels will print for all items 
accordingly. The labels will print to the label printer and the document(s) will print to the document 
printer. If adjustments need to be made for the labels, use the manual label print button in the lower 
section. 

Once the range is established the user can select OK to print the work order(s) to the printer.  

Note: When printing to the printer, when a work order has multiple releases for different customers on it 
and each customer record has a document set to print with the work order, all the print with work order 
documents print for every customer associated to the work order releases. 

Destination - To change the destination to something other than the printer first select the Destination 
tab and choose Screen, File, or Email. Note: Any documents associated to the BOM with the ‘Print with 
Work Order’ option selected will also print. 

Print Routing Packet 

The user can select the Print Routing Packet speed button . This will print a packet of instructions 
for each step the part must go through to become the final product for the customer. This report 
includes a page for all related work orders with operation details and material requirements. Also, any 
routing notes added to the item on the BOM on the Item Details tab will be included on the report. 
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Substitute Mfg # 

A Substitute Manufacturing # can be created for the work order. This feature will create a temporary 
Mfg # to run the item(s). This is useful for sampling different materials or to make adjustments for 
temporary changes to components used to produce the item(s). 

➢ To use this feature the work order must first be marked Firm. (The option is only available 

after Firm has been checked). This will prevent the default Mfg # from replacing the 
substitute one during the update schedule process. If the work order is scheduled in the 
first position an error will appear stating that substitution is not allowed. Creating a 

substitute Mfg # for work orders scheduled in other positions is allowed. 

➢ Next, select the Substitute Mfg # button (or select this option from the file menu) and 
confirm the action. A new BOM will appear with a Mfg # of SUB-#####. The substitute 

BOM will include all the details from the original BOM including materials, components and 
Runs the Best details. The substitute Mfg # will automatically be marked Inactive so as to 
not clutter the pick lists. The Mfg # field will be highlighted yellow on the work order. 

➢ Make the desired changes to the substitute Mfg #. Note, if you want to distinguish the items 
produced with the substitute Mfg # from parts made with the standard Mfg # be sure to 
change the FG Lot# on the substitute BOM or on the work order. 

➢ Substitute BOM’s will be deleted only if they are not on the schedule, and there is no work 
order in the system for the Substitute BOM, and the Substitute BOM is not on a production 
report. (This applies to all manufacturing types except the ASSY types). 

Note: When creating a Non RealTime production report the user will only be able to add a line item by 
selecting the Work Order. The Mfg # option will not work because the substitute BOM is automatically 
marked inactive which hides it from pick lists. 

Note: If a work order that is firm and has Components Based On set for Hard Allocation, when a 
Substitute Manufacturing # is applied to it, the system will automatically recalculate the Allocated 
Materials. This ensures backflushing of any components during dispositions is correct. 
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Material Allocation 

Once a work order has been marked Firm material can be hard allocated to the work order. Select 
the Material Allocation speed button and the Allocated Materials form will appear: 
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The top section displays the BOM tree view. It includes the basic item information such as item number, 
item description, UOM, quantity required, and on hand.  In Inventory->Additional tab there is a field 
'Hard Allocation Decimal Rounding'.  If the field is 0 or greater, in the Qty field, the quantity for the 
inventory will be rounded to the nearest number based on this value. If this field is null it will round out 
up to six decimals depending on the actual quantity required. Note: This is not applicable for Serialized 
Inventory Control items (SIC). The full quantity of serial(s) selected are hard-allocated regardless of this 
setting. 

There are also three additional fields; Substitute, Kind and Attribute.  

▪ The Substitute check box will be checked if the material is manually added as a substitute, or if using 
the 'Alternate Item# Applied to Work Order Allocation' feature where users can substitute alternate 
items from material exceptions for specific work orders.    

▪ The Kind field describes the type of item it is such as Top Item, Primary Material, Components, or 
Blend.  

▪ The Attribute field will display Blend or Blended at Work Center depending on the type of blend. Any 
Blends that are blended at the work center will be indented and the attribute for the components of 
the blend will display as Blend Component. The line item for a top item (the manufactured item) and 
any item with ‘Blended at work center’ as an attribute will be gray and they cannot be selected for 
hard allocation.  

Consume All - This option is only available for ASSY1, 2 and 3 Mfg Types. If checked, during Labor 
Reporting in ASSY1 or 2, or in Final Assembly in ASSY3, the system does not calculate usage, only the 
hard allocated amount is removed regardless of BOM parts per on the item. If the component does not 
have any hard allocated it will be skipped. 

For blends created as a Generic BOM (Phantoms) the manufactured item will display as the primary 
material and the components will also display (they will be indented). The phantom item Qty to Allocate 
will be zero but users are allowed to allocate it. The parts per for the phantom's components are based 
on the Parts Per of the phantom and the phantoms Parts Per to the parent item. Allocations can be made 
for the components of a phantom item.  

Compound and MBatch - For Compound and MBATCH MFG Types the item # column in the top section is 
colored yellow, and this section includes a column for Total Material Allocated and Total Percent. The 
Total Material Allocated is populated for the manufactured item with the total quantity hard allocated 
on the work order from the Total Allocated column.  The Total Percent is the sum of items (not 
packaging) specified to be allocated in the Percent field for Compound, or the Parts Per field for MBATCH 
(the system adds the top level (some might be blends) parts per and multiplies by 100 to get the Total 
Percent). If the Total Percent for each TOP ITEM is not 100 a warning will appear, and the user must 
correct it. If the allocated materials have been adjusted, and are under or over, when closing the form a 
warning will appear stating, 'You have under/over-allocated material. Would you like to recalculate the 
Percent and Parts Per columns based on the Total Allocated?' Selecting Yes will ensure that when 
reporting a partial of a work order through PRW that the correct quantity of materials are removed from 
inventory during disposition. There is also a button (lightning bolt) that will perform this function.  

Notes: 
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When changing material or adding components to a substitute mfg #, the user must recalculate the hard 
allocation requirements. 

After adding/substituting material in the hard allocate screen and running update schedule, update 
schedule will calculate any material exceptions for the added/substituted material. 

Adding/substituting material for Assy1/2/3 is not recommended through Hard Allocation because the 
item is not produced at the process level. It is recommended to use Substitute Boms. 

The bottom left section will display any materials that have been hard allocated and the existing location 
information such as lot number and on hand. 

The bottom right section displays the items inventory locations and details. Locations that are already 
hard allocated will be highlighted aqua blue; MTO will be lavender, and Expired locations will be red. 
Non-conform locations that are marked 'Allocatable' will be included in the location list. 

Substitute Material for Hard Allocation 

The Hard Allocation screen defaults to the items and quantities required to manufacture the product 
based on the BOM. Substitutions and additions can be made from the Hard Allocation form. 

Add Item - To add an item to allocate either select the Insert (+) button or right click and select 'Add Item 
to Allocate'. The Select Substitute screen will appear: 
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To choose a substitute from inventory select the ellipsis button in the Item # field and a pick list of all 
master inventory items will appear to chose the item from. To choose from the list of Alternate Items, 
first depress the 'Use Alternate Items List' button and then select the ellipsis button in the Item # field. 
Only the items that have been set up as alternates for the default item will appear in the list. The 
Consumption Type will default to Unknown or N/A but can be changed to Primary Material or 
Process/Operation by checking the appropriate box. If Primary Material is selected the Kind field on the 
main Allocated Materials screen will display Primary Material, if Process/Operation is selected the Kind 
field will be Component. Once an item is added, enter the 'Parts Per' field and the system will 
automatically calculate the 'Qty' to allocate field. (The parts per defaults to one). The added item will 
have the Substitute box checked and will display in blue text. 

Remove Item - To remove an item from the Allocated Material list, select the delete (-) button. 

Recalculate Hard Allocation requirements 

Select the calculator button at the top of the form to recalculate the BOM tree and hard allocation 
requirements, and cancel any existing hard allocations.  

Note: If deletions or additions were made to the materials, when the user recalculates the requirements, 
the system will add back any items that were removed if they are from the BOM. The items that were 
added manually will still remain in the hard allocated screen.  

Note: Before allocating material, the ‘Recalculate Hard Allocation Requirements’ needs to be run when: 

▪ Using a substitute BOM  

▪ Changing the MFG # on the work order  

▪ Changing the quantity on the work order  

▪ Any combination of the above. 

Inventory Locations 

There are two tabs in the Inventory Locations section (note the tab the user is focused on is remembered 
in the registry):  

▪ Trans Locations - For users with the Advanced WMS license this tab will display the location to use 
based on the Inventory Transaction Location Plan. This tab can also be used to designate a specific 
location manually and then use the 'Allocate All Locations' feature (described below). 

▪ All Locations - This tab will display all the locations associated to the highlighted item. It will not list 
non-conforming locations unless they are marked 'Allocatable'. 

Allocate Materials from All Locations tab 

To hard allocate a material from the 'All Locations' tab, highlight the material in the top section and 
select the arrow left button in the lower section. A form displaying the existing locations associated to 
the item will display. (New locations cannot be created). Expired items will display in red, Hard Allocated 
displays aqua blue, and MTO lavender, so users can differentiate the locations. The inventory locations 
grid can be filtered by clicking the 'Filter dataset' button. The filter setting will carry over to the Allocate 
Material form as well. For example, if the locations grid is filtered for a specific location, the Allocate 
Material form will also only display that location. 
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The Qty to Allocate field will display the calculated requirements for the item. In Inventory->Additional 
tab there is a field 'Hard Allocation Decimal Rounding'.  If the field is 0 or greater, in the Qty to Allocate 
field, the quantity for the inventory will be rounded to the nearest number based on this value. If this 
field is null it will round out up to six decimals depending on the actual quantity required. Note: This is 
not applicable for Serialized Inventory Control items (SIC). The full quantity of serial(s) selected are hard-
allocated regardless of this setting. 

Highlight a location/lot to allocate the material from and enter the quantity to allocate or leave it to the 
calculated value.  Press OK to allocate the material. Multiple locations can be hard allocated. If the 
entire calculated portion is not hard allocated with the first selected location, the user can select the 
arrow left button again and the Qty to Allocate form will display the remainder to be allocated. Select a 
location and press OK to allocate the rest of the material. If the user attempts to exit the hard allocation 
screen before allocating all materials a warning will appear stating. “Not all of the required materials 
have been allocated in full. Would you like to correct it now?”. Select Yes or No to continue.  

A move transaction takes place that moves the calculated or user modified quantity to the new location 
and a new fgmulti row is added with all of the same information as the chosen location (such as lot 
number). The WO # field in the transaction log will be populated with the work order the material was 
allocated to. The location in Inventory->Transactions and Locations will be marked in blue and the work 
order it has been allocated to will display in the Hard Allocated field. The hard allocated locations are 
"locked down" in the inventory module. The only out transactions that are allowed must be for the 
designated work order. And the following rules apply to inventory moves for hard allocated locations: 

When moving from a hard allocated location to: 

▪ Another hard allocated location associated with the same work order, a regular move is executed.  

▪ Another hard allocated location associated with a different work order, a new location is created. (In 
the same manner as when lot #’s do not match).  

▪ Any non hard allocated location, a new location is created like when lot #’s do not match. 

When moving from a non hard allocated location to: 

▪ A hard allocated location an error is raised. 

▪ Any non hard allocated location, a regular move is executed. 

If the user attempts to hard allocate to a 'No Backflush' location a message will display: 'Unable to hard 
allocate to a No Backflush location'. Select OK and choose another location. 

If the Qty to Allocate is manually changed to a different value than what is calculated, the only time the 
system will use that value is in Production Reporting by Work Order and only when the 'WO Completed' 
option is checked. For other transactions, such as a manual transaction, the system will use the Parts Per 
in the Hard Allocation instead of the Parts Per in the BOM. 

For Serialized Inventory Control items the system will perform another check of the current serial status 
in inventory when the user clicks the OK button to complete the material allocation. If the serial status 
has changed (e.g. location or quantity), a message will surface stating, 'The Location(s) associated to the 
label(s) in this transaction are no longer current - operation aborted'. 
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Allocate Materials from Trans Locations tab - Allocate All Options (For users with the Advanced WMS 
license) 

To hard allocate a material from the 'Trans Locations' tab, highlight the material in the top section. For 
Advanced WMS users select the 'Trans Location Plan' button to calculate the location plan. The 
calculated locations will populate on the Trans Locations tab. For non Advanced WMS users or to 
manually select location(s) select the Insert (+) button on the Trans Locations tab. A pick list of locations 
(FGMULTI locations) associated to the item will appear to add to the Trans Locations tab.  Multiple 
locations can be selected and users can edit the Qty field.  Modifications are saved when the user 
leaves the hard allocation form and goes back in at a later time. 

Once locations for all of the items have been selected  from the 'Trans Locations' tab choose an 

allocation option from the drop down list on the Allocate All speed button . 

▪ Allocate All Locations - When this is selected, the system will hard allocate all the 
material/components/pkg/etc based on the Trans Locations tab.  If the item is a Serialized 
Inventory Control (SIC) item, the user will see the Linked Labels form to select the serial(s). 

▪ Allocate and Move to Dispo Location - When this is selected, the system will hard allocate all the 
material/components/pkg/etc based on the Trans Locations tab.  If the item is a SIC item,  the 
user will see the Linked Labels form to select the serial(s). The hierarchy is: 

1. Staging Location beneath the Trans Location grid 

2. Work Center Dispo Out location 

3. Mfg Cell Dispo. Location 

4. The selected location(s) under the Trans Location grid 
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Note:  When adding a Trans Location, if the Transaction Plan is not in place for the work order, 
consumed material and the master location, a warning message will surface: "Could not add record. 
Record not found in v_inv_trans_plan [source = 'WORKORDER_BOM', source id = xxxx]." A Transaction 
Plan  must be in place before a location can be added. 

Note: When material has been allocated to a work order through an Inventory Transaction Location Plan, 
the allocation is removed and the plan is deleted when the work order is deleted. 

Cancel or Edit a Hard Allocation 

To cancel or edit a single hard allocation, highlight the line in the lower left section and select the Arrow 
right button. Select Yes on the Confirm box. The Allocate Material pop up box will display with the hard 
allocated location highlighted.  

To edit the hard allocated location select a different location from the list and select OK. The location 
that was added when the item was hard allocated will be toggled back to a non allocated location. And 
the new location will be toggled to a hard allocation location for the work order. 

To cancel the hard allocation, select 'Cancel' from the Allocate Material box. The location that was added 
when the item was hard allocated will be toggled back to a non allocated location. No transactions will 
occur. 

Right Click Options 

From the top section the user can right click and select: 

▪ Add Item to Allocate- Opens the Select Substitute screen to add an item (described above). 

▪ Jump to Inventory 

▪ Item Transaction Log 

Speed Buttons 

Recalculate Hard Allocation Requirements - Select the calculator button at the top of the form to 
recalculate the BOM tree and hard allocation requirements, and cancel any existing hard allocations.  

Advanced Filter - The locations displayed can be filtered based on Warehouse/Division or Work Zone 

Locations by selecting the Advanced Filter button at the top of the Material Allocation form . 
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▪ None will display all of the item's locations.  

▪ Warehouse/Division  - To filter for only locations associated to a specific Warehouse/Division, select 
Warehouse/Division and then select one from the pick list accessed by clicking on the ellipsis button.  

▪ Work Zone Locations  - Select Work Zone Locations to filter the locations based on locations that 
are associated to the work zone(s) the logged in user is associated to.  

The filter setting is remembered in the registry. 

Trans Location Plan - This will only be visible for users with the Advanced WMS license. This will calculate 
the location plan based on the established inventory transaction rules. 

Directed Staging Report - This will print the Directed Staging Report. This report will list the Transaction 
Locations for each raw material from the ‘Trans Locations’ tab on the location plan. The report is 
assigned on the System Parameters->Reports and Forms tab. The default report is called 
direct_staging.rpt. 

Allocate All - This button accesses the two allocate all options described above. 

Dispositioning against hard allocated locations. 

Any disposition/backflush that knows what the work order is, will consume the hard allocated 
location(s). If there is not enough on hand in a hard allocated location the system will look for another 
hard allocated location for the same work order.  If none are found the hard allocated location will be 
driven negative. If the location is brought to zero and the 'Delete Empty Locations' Inventory Parameter 
is checked, it triggers the system to remove the hard allocate/disposition designator status and the 
system will delete the location. When ‘Delete Empty Locations’ is turned off the empty hard 
allocate/disposition designator location remains, but users can right click to release the hard allocation 
and this will also remove the disposition designator status from the location. 

Notes:  

If an item has been hard allocated on a work order (ex: attached packaging item) and the item is marked 
as ‘Exclude Backflush’ on the BOM Item Details tab, during Production Reporting for this WO, the item 
will not be excluded from backflushing.   

Hard Allocations can also be viewed, added and edited from the Scheduling module. Select 
Requirements->Hard Allocated to WO. See the Hard Allocated to WO Scheduling section for details. 

If hard allocating components to a work order that is a family tool, with all items using the same 
component, after a partial disposition the Allocated Materials screen from the work order will show 
reducing the allocation quantity on only one of the family items.  This continues until that item is used 
up and then the other items’ allocation are reduced.  The end result is a wash, but in the period in 
between a partial disposition and complete disposition, when going into the Allocated Materials screen 
and exiting, you will get a message saying “Not all of the required materials have been allocated in full.  
Would you like to correct it now?” 

The 'Components Based On' field on the work order will display BOM unless the components have been 
hard allocated. If material has been allocated, deleted, or added it will display 'Hard Allocation'.  
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If the Option (Work Order->Options menu) 'Release Hard Allocated Material on WO Archive' is checked, 
when a WO is archived, the system will release the hard allocation on any remaining material hard 
allocated to the work order. 
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Manual Work Orders 

Manual work orders are generally used in the early implementation stages before actual sales orders 
have been entered or to produce parts where no demand (sales orders or auto MRP) is present. 

Manual work orders are handled differently by the system than a generated work order. The following 
information describes the business rules that govern manual work orders: 

▪ If a manual work order in RealTime has been complete (running negative parts to go) it will not ever 
be returned to the scheduling pool as it is finished. 

▪ If a manual work order in RealTime has not been completed (running positive parts to go) and the 
check box on the setup form says return to scheduling pool, it will be returned. 

▪ Lower level work orders will not be generated automatically from a manual work order unless it is 
marked firm. If the manual work order is marked firm then lower level work orders will be generated 
automatically when update schedule is run. 

Creating a Manual Work Order 

To MANUALLY enter in a Work Order, complete the following steps. 

➢ From the EIQ Launcher Bar, find the tab entitled Mfg and select the Work Orders button. Select 

New from the pick list, or from within the Work Order entry screen select the ADD [+] 

function key located on the Navigator bar. 

➢ Next, select the item (or configuration number) from the pick list and click on [Select] to 

continue. 

➢ The Configuration # will be entered into the main order entry screen and the user will 
receive the following prompt: ‘Assign Customer [Customer Name] to the Work Order? Yes or 
No’ 

➢ If “Yes” is selected, the customer will be assigned to the Work Order. 

Changing the Customer 

As each order is entered, the user is given the option of changing the default customer. This is one 
method of allowing any item number to be sold to any customer. If “No” is selected when asked to 
assign the customer to the work order, the Configuration number selected will be assigned without a 
customer. 

To CHANGE the customer assigned: 

➢ Select the ellipsis button next to the customer field and highlight the customer in the pick list 
and click on [Select] to accept the choice. The customer will then be assigned to the work 

order. 

Entering the Quantities and Delivery Dates 
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Delivery dates drive the requirements generated by the system. The more accurate and complete, the 
better the system can assist in terms of scheduling production. Follow the customer’s Purchase Order as 
closely as possible when entering the delivery dates. 

In this portion of the work order entry screen, the user will enter the quantity and date that the parts 
should be completed by. 

Note: If a manual work order is created with a quantity greater than the Max WO Batch Size a status 
exception will appear stating 'Max WO Batch Size Exceeded'. It will include the WO #, BOM#, WO 
quantity and Max WO Batch Size. The form includes OK and Cancel buttons. Security can be placed on 
the OK button. For family tools, if any item exceeds the BOM Max WO Batch size, the status exception 
will surface.  

Note: Manual work orders do not take into consideration the time it takes to ship the parts to the 
customer. If the manual work order is used to fulfill demand from a customer be sure to make the 
delivery date early enough to allow for shipping time. 

As mentioned, space is provided for an unlimited amount of delivery dates per part per order. The Order 
dates can be easily changed or updated at anytime. 

Complete the following steps for entering in the quantities and delivery information. 

➢ Highlight the item (part) number that is displayed in the lower left corner of the Work Order 
module (Configuration Details). 
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In some cases, the Configuration may contain multiple part numbers (Family Tools), the lower left corner 
of the module will display all parts within the standard as shown in the example above. 

➢ Select an item number, then place the cursor in the quantity field in the adjacent window. 
Enter the order quantity for this item. The system will calculate the cycles required bases on 

the quantity on the work order and the number of cavities in the tool. 

NOTE: On manual work orders the total cycles required does not change when the cavitation on a part 
number changes. Manual work orders are manual and are not changed when BOM's change. They would 
have to be edited if the part number cavitation change was going to be permanent. 

➢ Enter the delivery date that the parts should be completed by. 

➢ Order Number: This field is optional. Enter an Order Number. 

➢ PO number: This field is also optional. Enter the customer’s purchase order. 

After the delivery data is entered, information will then be displayed in the following non-editable fields 
Material, Center Type, Setup hours, Cycle, Production Hours, Must Start Date and End Date. The 
“Scheduled” field will not contain any information until Update Schedule has been ran and the Work 
Order has been scheduled. The bucket number will be blank because manual work orders are not 
assigned a bucket number. The screen below shows a completed Work Order which has also been 
scheduled. 

Note: The system will calculate the Must Start date for manual work orders as the lesser of the system 
date or the calculated date. This does not apply to manual Outsource work orders. The must start date 
will stay the calculated date. 
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Note: Manual work orders cannot be created for BOM’s with a very small cycle time, such as .001. An 
error will occur: “Failed to AppDef: General SQL error. ORA-20100: Cycles per Hour = 0. Unable to 
calculate work order [###}. Please verify BOM configuration!” If the work order is not removed or the 
BOM is not corrected update schedule will fail to run. An error will display indicating the work order 
number that is causing the issue. 
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Rework Work Orders 

Another type of manual work order is a Rework work order. This is used to perform rework on an item. 
Rework work orders are typically created from the RMA or MRB modules but they can be created 
manually from the work order module. 

They are created in the same manner as any manual work order. When selecting the Manufacturing # a 
Rework MFG Type BOM is selected. These BOMs are created from the BOM module or they can be 
created on the fly from the RMA or MRB modules. (Please see Mfg Rework Order for more details). 

On unique feature of a Rework work order is the ability to associate a non conforming location to the 
work order allowing for backflushing from specific currently existing non conform locations. 

From the Work Order select the ‘Assign Rework Non Conforming Locations’ speed button  in the 
Configuration Details section.  Select the ellipsis button in the Non Conforming Location field. A pick list 
of non conforming locations associated to the item will appear. Select a location from the pick list. Select 
the insert button to associate additional locations. 
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Generated Work Orders 

This section explains the functions and processes used by EnterpriseIQ to generate Work Orders. Once 
created, material and capacity requirements can be determined. 

Re-generation and Net Change 

The work order system is re-generative, meaning that EnterpriseIQ completely builds the requirements 
essentially from scratch each time Update Schedule is run. This technique ensures that all changes to 
sales orders, inventory, shipments, and min/max levels are taken into account. 

Schedule Scope and Run Size 

The system uses the Scheduling Scope and Run Size values when creating work orders. 

Schedule Scope 

Scheduling Scope in Days, is a value set in the Scheduling Parameters form of the scheduling module.  
 
The Scheduling Scope in Days value determines how far into the future the system should look for 
planning purposes. For example, a value of 120 will tell EnterpriseIQ to include only those orders and 
releases that occur in the next 120 days. For greater long term visibility, this value can be set higher. 

Run Size 

Work orders are time-phased, meaning that a work order is based on user defined criteria determining 
how much of a product should be produced within a given time frame. Each product can carry a unique 
time frame, called the Mfg Run Size in Days. 

The Run Size can also be set from the Scheduling Parameters form globally. This value, however, can also 
be set in each BOM configuration, allowing each job to maintain a unique run size. If a BOM does not 
have a value assigned, the global parameter is used. This value is stored with each BOM, and can be 
found under Options|Miscellaneous Parameters|Scheduling. 

Under most circumstances, this value is set between 5 and 15. This effectively tells the system that we 
only want to produce enough product during a run to cover 5 (or 15) days of product releases. The 
system will accept a run size as small as one but it is not recommended. 

The lower the number, the more tool changes are usually required. The higher the number, the more 
inventory you will probably carry. 

Update Schedule, found within the Scheduling main screen under the File menu option, is used to 
automatically build work orders. This module performs the analysis of inventory and sales orders and 
determines what must be produced. The result is a series of work orders that match the current 
production needs. 
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Note: Both these values are production days based on the Shop Calendar setup. 

Sales Demand and Inventory 

The first major step Update Schedule performs is an analysis of sales orders. It groups like parts together 
and develops a total number of parts required, based on the Scheduling Scope. The total will not include 
orders and releases beyond the value of the scheduling scope. 

This list of parts and their totals is then compared against the on-hand inventories found in the master 
inventory table. The total number of parts required is discounted by the amount found, leaving a grand 
total of parts needing to be created and/or shipped in the next X number of days. 

Dynamic Allocation 

It is during this phase, that the system also compares the quantity on hand against the release dates. 
Using a technique called dynamic allocation, the releases with the earliest dates are assigned the current 
inventory, until the on hand quantity is fully allocated. The remaining demand is where the next phase 
begins. 

Note: Make to order inventory is ignored during allocation to dynamic allocation sales orders.  Make to 
order detail releases demand will only look at the on hand inventory allocated to that order detail. 

The second major step is to determine exactly when the parts need to be made. This is where the Run 
Size value comes into play. 

With a list created showing total demand, the system then breaks the requirements into “buckets” based 
on the Run Size. Each bucket is in effect a unique work order. Under most circumstances, the buckets are 
scheduled in sequential order. This is logical because each bucket contains only those amounts needed 
to cover the particular time frame. 

Example 

Assume the following: 

▪ BOM number 103TI creates part number 38-123, a motor housing. 

▪ Schedule scope is set at 90 days 

▪ Run Size scope is set at 15 days. 

▪ On Hand inventory = 3500 parts with no other pending sales orders. 

A sales order is then entered for this part with the following release schedule: 

Table 1: Release Schedule 
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Date Quantity 

03/02 5000 

03/06 5000 

03/10 5000 

03/20 4000 

03/27 4000 

04/02 5000 

05/04 5000 

05/08 2000 

05/27 3000 

06/15 5000 

07/15 5000 

08/14 5000 

Totaling this release schedule (and assuming no other order in the system requires this particular part), 
we can see that the total demand for part number 38-123 is 53,000 parts. 

Assume, however, that today’s date is February 28. Because our Schedule scope is only 90 days, 
EnterpriseIQ will only include those dates from March 2 - May 29. Therefore, the total quantity of 
concern is only 38,000. 

Please note that the date range is a moving value - had the function been run on the 17th of March, the 
June 15th quantity would have been included. 

With 38,000 parts required in the next 90 days, EnterpriseIQ then allocates the on hand amount (3500) 
against the first release date(s). In this case, we can cover only a portion of the first release, with 1500 
still needed. (5000 - 3500 = 1500). Our final required balance therefore is 34,500 parts to be produced in 
the next 90 days. 

Creating the Buckets 

The next step is to break the total demand into their run sizes. In this example, the run size has been set 
to 15 days. 
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Beginning with the first release date (March 2) EnterpriseIQ adds 15 days and gathers all other releases 
within that range. Here, we would find the first, second and third releases meeting this criteria. Since we 
know that 3500 parts are already available, the first bucket will be for a total of 11,500 parts (5000 + 
5000 + 5000 - 3500 = 11,500). 

EnterpriseIQ assigns an internally generated Work Order ID number, and also creates a “bucket” number. 
This bucket represents the first group of releases included in the work order. In the example above, the 
bucket is 103TI - 1. 

Because there are still more releases to go, EnterpriseIQ continues it’s evaluation. The next date so far 
not accounted for is March 20. Beginning with this date, EnterpriseIQ adds another 15 days and groups 
releases four, five and six (03/20 + 03/27 + 04/02). Because the on hand balance has already been 
allocated, the second work order will contain a requirement for 13,000 parts (4000 + 4000 + 5000 = 
13000). 

EnterpriseIQ will assign the next work order ID number, and increment the bucket number to show this is 
the second major group of releases. It would appear as 103TI - 2. 

The next work order generated will include the May 4 and May 8th dates, but not May 27th since that is 
more than 15 days from the May 4th date. This group is called 103TI - 3 for a total of 7,000 parts. 

The final group will include the May 27 release, for 3000 parts and will be called 103TI - 4. 

In this simple example, the system has created four distinct groups of work order releases, covering the 
total amounts required in the time frame required. 

Note: Manufacturing Run Size is based on the Shop Calendar days, not Calendar days. 

Must Start Dates 

Work orders carry a must start and a calculated end date. The must start date is based on the following: 
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▪ The must start calculation starts with the Sales Order promise date. 

▪ EnterpriseIQ assumes that a promise date is a dock date to the customer. Therefore, shipping lead 
time is taken into account when determining the must start date. The system adds the number of 
days it takes to ship to the customer to come up with a Must Ship date.  (The shipping lead time is 
stored in the customer master file, under the Ship To tab). There are additional considerations for 
the Must Ship Date calculation such as specific shipment days. (See  Calculating the  Must Ship 
Date for more information). 

▪ The Must Ship Date is adjusted based on the Wait Time in days associated to the item if a value is 
specified on the Manufacturing tab in Inventory. (Wait Time is subtracted from the Must Ship Date 
before calculating the Must Start Date).  

▪ Move time in days are also used in the must start calculation. This value can be added to an item on 
the Manufacturing tab in Inventory. (Move time is added to the lead days for the item). 

▪ Next, the production time is considered. This is the number of hours required to produce the 
product, based on the values stored within the BOM (cycle time, cavitation, efficiency factor). 

The end date is the calculated date assuming the job is run on the must start date. Under most 
circumstances it is recommended that jobs be scheduled well prior to the must start date. 

Must Start Date Example: 
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Other Work Order Factors 

Of course, the plant floor environment is rarely as straight forward as the example suggests. Here are 
some other factors that are taken into account each time work orders are generated. 

Other orders, same 
part, different POs 

EnterpriseIQ makes no distinction between orders and POs when determining the total 
demand, and when creating work order buckets. A single work order can contain as many 
releases from different orders, customers and POs as found. This means a single run can 
potentially produce enough parts to fill many orders and releases. 

Bucket End Date, 
Changes to Work 
Orders and the 
problem of Bucket 
Creep 

Each day, the schedule scope includes another day in the overall requirements. Under the 
right circumstances, future releases might “creep” into earlier buckets as the days between 
delivery releases are re-evaluated. This is not a problem under most circumstances, but can 
be a major problem for jobs already running. 

The concept of a “Bucket End Date” is introduced to handle these special circumstances. 
The last release date within the bucket is regarded as the bucket end date, and only has 
importance if the work order is in the FIRST position of the work center schedule. 

Any changes to existing releases within a bucket 1 work order are included in the next 
Update Schedule run, even if the job is currently running. This includes changes to 
quantities and the deletion of releases. If a new release is included in a new order, and the 
release date falls BEFORE the bucket end date, the work order is adjusted to include the 
new release. 

However, if a new release (or existing release) is found to be within the Run Size scope, but 
AFTER the Bucket End Date, it is NOT included in the bucket 1 group of release. Instead, it 
will be placed in the next bucket. 

Remember - this situation is only valid if the job is scheduled in the FIRST position of the 
work center. 

WIP and Work 
Orders 

Work In Process parts (WIP) are handled during the work order update procedure. Finished 
goods that consume other parts generate work orders automatically for the lower level 
(sub assembly) part(s). EnterpriseIQ employs “levels”, a technique whereby all parts that 
make up the final assembly are taken into account when building work orders. 

For example, assume part A (level 0) consumes part B (level 1). When an order is placed for 
part A, EnterpriseIQ will evaluate and generate the appropriate work orders - for part A and 
part B. 

Scheduled 
Allocations 

EnterpriseIQ takes the concept of family tooling to completion by including the ability to 
forecast the availability of parts based on the family tool. 

For example, assume that a sales order demands Part A from BOM 103. This BOM actually 
creates two parts - parts A and B. EnterpriseIQ understands that the production run will 
produce both parts. 

Both part numbers are taken into account when determining product availability. This 
system of allocation works in the same way on hand inventories are allocated. If a work 
order is already going to produce a part another sales order demands, then that demand is 
discounted by the number of parts the original work order will produce. 
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Additional Notes: 

Following are two business rules that apply to all types of work orders in regards to RealTime and 
scheduling: 

▪ If work orders for the same item (i.e. Bucket 1 and 2) are scheduled back to back and the first one is 
running negative parts to go, the negative amount will be applied to the next work orders quantity. If 
this is not desired add downtime in between the two work orders and the quantity from the first 
work order will not carry over to the second one. 

▪ If work orders (any kind) are scheduled back to back and the first one is running positive parts to go 
the next work order on setup will NOT have any cycles/parts applied to it from the first work order. 
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How to Generate Work Orders - Update Schedule 

The Update Schedule process is used to build work orders: 

➢ From the Finite Scheduling module, open the File menu and select 'Update Schedule-> 
Regenerate Schedule' 

The following screen will appear: 
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This screen shows the current work order information. The list contains only generated work orders, and 
does not show manually created work orders unless they are marked firm. 

➢ Click the 'Recalculate' button at the bottom of the screen. The system will complete the 

following steps: 

▪ Reset all manufacturing quantities 

▪ Set back all orders 

▪ Allocate by levels 

▪ Group orders into buckets 

▪ Merge work orders 

The system will then re-evaluate the work centers, update dependent tables, and process available 
hours for each work center. The length of the process depends entirely on how many jobs, work centers, 
materials, and releases are included. This process is done for all EPlants at the same time. It cannot be 
EPlant specific as it is necessary to ensure supply and demand is evaluated across all EPlants 
simultaneously so that the requirements from one EPlant to another is accurate. 

The update schedule process also performs the functions described in the screen shot below: 
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When the process has finished, a prompt will appear in the Update Status box that will inform the user 
that the process finished successfully. 

Note: During the Update Schedule process, a prompt will appear informing any individuals who are trying 
to enter into the Scheduling module. The prompt will read “Time-out-unable to proceed. Failed to 
acquire share. Update Schedule process is currently in progress. Please try again later". This feature 
helps to eliminate a double execution of Update Schedule and other errors that tend to occur during 
updating. Users in the scheduling module will receive a message that the schedule is being updated and 
they should exit. 

Note: There are only a couple of places where you will possibly experience lock messages when running 
update schedule. They are when making changes to the finite schedule and when accessing inventory 
availability. Floor dispositions, manual transactions, etc. can be done during update schedule. It is best to 
do production dispositions just prior to running update schedule so that the most up to date information 
is available to the MRP run, but that is not to say they cannot run at the same time. There is no need to 
stop the use of the scanners for inventory moves or dispositions during the run of update schedule. 

Note: Update schedule will not allow buckets to be scheduled out of sequence. Update Schedule will re-
bucket if a user schedules out of sequence manually. 

Net Change Schedule 

There is another Update Schedule Option called 'Net Change Schedule'. This option evaluates Sales 
Order releases for any changes/additions to Quantity and Promised date since the last time Update 
Schedule or Net Change Schedule were run.  The system will record when changes are made for Net 
Change tracking purposes, allowing the system to know if the item has been processed. If changes or 
additions are found, work orders will be updated/created as required.   

Notes: 

Net Change requires the user to be logged into an EPlant, and Net Change Schedule only applies changes 
to that EPlant.  

The Event Log for Irv32 Info will be logged for Net Change and the EPlant ID.   

Net Change Schedule does not perform other functions in Update Schedule such as material 
requirements, work center capacity, etc.  

IQAlert 

Update schedule can be run through IQAlert. Alert can be set up to run update schedule when it suits 
your company's needs (including at night). It is recommended to let everyone know of the scheduled 
time(s) and put security on the option to run update schedule. If it becomes necessary to run update 
schedule outside the scheduled times you can alert the necessary parties ahead of time and only 
designated personnel can run update schedule.  (Please see the IQAlert documentation for more 
information). Note: If update schedule does not finish successfully when run from IQAlert an error will be 
entered in the Event Log. The Event Log can be accessed from the File menu of the EIQ Launcher Bar, 
select System->Event Log. Select the IRV32 INFO Log Class for details.  
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MRP Engine 

The MRP engine is typically used to just run update schedule, but this form can also be used for trouble 
shooting purposes. Each line item has a PTALLOCATE ID, an ARINVT ID, ORDER ID, etc. These ID’s can 
help users to troubleshoot possible errors in BOM’S, scheduling, etc. 

The MRP Engine screen can be sorted based on any field in the main section. To change the sort click on 
the column header of the desired sort field. Users can also search for a specific item in the list by typing 
information based on the sorted field in the white search area above the columns. For example, to find a 
specific Mfg #, click on the Mfg # column header to sort by that field. Then start typing the specific Mfg # 
in the white field and notice that the list will hyperbrowse to the desired line item. Once the item is 
found users can scroll across the screen to view additional information such as must start, ship Qty, and 
item information. 

Field Listing 

ID PTALLOCATE ID 

Level BOM Level 

Mfg # Manufacturing number 

Bkt Work Order bucket number 

Must Start Work Order Must Start Date 

Ship Qty The quantity of the demand (Release qty, forecast, dependent, etc). 

Mfg Qty The quantity to be manufactured. 

FG Alloc The quantity allocated from existing on hand. 

Sched Alloc The quantity that is available based on the family tool.   

For example, assume that a sales order demands Part A from BOM XYZ. This BOM actually 
creates two parts - parts A and B. EnterpriseIQ understands that the production run will 
produce both parts. 

Both part numbers are taken into account when determining product availability. This 
system of allocation works in the same way on hand inventories are allocated. If a work 
order is already going to produce a part another sales order demands, then that demand is 
discounted by the number of parts the original work order will produce. 

Sched Ext Allocate This displays the amount of forecast used to reduce the normal demand. For example, 
forecast equals 1000 and demand is 1500. The system will use 1000 from the forecast and 
manufacture 500. The 1000 will populate in the 'Sched Ext Allocate' field. 

Firm WO Alloc The quantity allocated from Firm work orders 

MakeToOrder Alloc The quantity allocated to the Make To Order sales order 

PO Alloc The quantity allocated to a purchase order (DRP demand?) 
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Item Information There are several Item Information fields relevant to the inventory item associated to the 
PTAllocate record: 

▪ Item # 

▪ Item Description 

▪ Item Rev 

▪ Item Class 

▪ Ext Description 

Parent ID The PTALLOCATE ID for the parent item causing the demand 

Order # The sales order number associated to the demand. Users can jump to the sales order from 
the lower left section right click option. 

Origin This will be blank or FIRM if the associated work order is marked 'Firm'. 

Note An Allocation Note will display when applicable.  

Examples: 

▪ Split system added ptallocate 2066077 and sched alloc to 2065858 

▪ System added due to family generated demand or cycle rounding (Refer to the Bottom 
Section on a Work Order topic for details on additional demand that is added by the 
system. 

Order Type This will blank or state AUTO-MRP when the demand comes from Auto-MRP (eKanban). 

Division ID The Division/Warehouse ID associated to the record. 

WO Max Batch Size This displays the 'WO Max Batch Size' associated to the BOM. 

Group Code The 'Group Code' associated to the Inventory Item. (Group Codes are assigned to items on 
the Inventory->Additional tab). 

Note: Firmed work orders that are scheduled on the finite schedule outside the scheduling scope setup in 
scheduling parameters will not be visible in PTAllocate or in the MRP Engine. These work orders will still 
affect the schedule allocate on other work orders. 

Sales Order, Bucket, Work Order, and Log information will be visible for the highlighted item in the lower left 
portion of the screen  

Sales Order The Sales Order tab includes: 

▪ Sales Order ID 

▪ Ord Dtl ID 

▪ Requested - Sales Order Requested Date 

▪ Promised  - Sales Order Promise Date 

▪ Must Ship  - Sales Order Must Ship Date 

▪ Order # - Sales Order number 

▪ Prod Hrs - Production hours required for the specific record 

▪ Cycles Req - Required cycles required for the specific record 

▪ Standard ID - BOM ID 

▪ Arinvt ID - Inventory ID 
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Bucket Bucket details: 

▪ ID - Bucket ID 

▪ From - The From date for the bucket 

▪ To  - the To date for the bucket 

▪ Bucket # - Bucket number 

▪ # Cycles - Number of cycles required for the bucket (work order) 

▪ Prod Hrs - Number of production hours required for the bucket (work order) 

Work Order Work Order tab details: 

▪ ID - Work Order number  

▪ Start - Work Order Must Start Date 

▪ End - Work Order End Date 

▪ Act Bkt# - Bucket number 

Log The Log tab will show information such as overlap hours used. For example: Overlap hours 
= 3 was used to calculate the must start date 11/28/2013 05:22:23 and must_ship_date 
11/28/2013 09:55:54.  



Work Orders Page 53 of 66 

 

Jump To Options: 

There are four jump to options available in this section, from all tabs: Jump to Work Order, Jump to 
BOM, Jump to Inventory, Jump to Sales Orders. When selected the corresponding module will appear for 
the highlighted record. If there is not a record associated to the item a "Jump information is unavailable" 
message will display. If the record is associated to an EPlant that the user is not logged into an "EPlant 
mismatch" message will display. 

Action Section 

The lower right portion of the screen displays the actions completed during the update schedule process 
and the time in seconds it took to complete the task. The bottom bar will display the number of records 
processed and the last date and time it was recalculated. If update schedule does not finish successfully 
an error, in red, will appear here stating, 'Last Recalc: ERROR – see eventlog'. 

The Event Log can be accessed from the File menu of the EIQ Launcher Bar, select System->Event Log. 
Select the IRV32 INFO Log Class for details. If update schedule fails in IQAlert the error message is 
written to the Event Log like when running update schedule via EIQ. 

Troubleshooting 

Below lists a couple examples of error messages that may occasionally appear and the reasons for the 
errors. 

▪ An error may occur stating that there is the same MFG # scheduled on more than one press in first 
position. To correct this problem go to the Troubleshooting menu on the MRP Engine form and select 
‘Verify Current Running Mfg # Uniqueness.’ A pop up box will appear showing the work center and 
manufacturing number information that is causing the error. Once the duplicate is found, remove 
the job from one of the work centers and rerun update schedule. 
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▪ General SQL Error: ORA-20500: ORA-01403: No data found action: ASSIGN_MFG_CONFIG 
PTALLOCATE_ID = 1131751 ORA- 06512: at 'IQMS.IRV32' LINE 384 

This error is typically caused by an item that no longer has a default manufacturing number associated to 
it. Users can look up the PTALLOCATE ID in the MRP Engine screen and view the associated Item #. Once 
the inventory item is determined, users can go to the inventory module to fill in the default Mfg number. 
Once the correction is made, rerun update schedule. 

▪ General SQL error ORA-01436: CONNECT BY loop in user data ORA-06512: at ''IQMS.WO_ROUTE'', 
line 45 ORA-06512: at ''IQMS.WO_ROUTE'', line 36 ORA-06512: at ''IQMS.IRV32'', line 2691 ORA-
06512: at line 1 

This error message listed above is caused by one of two scenarios: 

1.  A BOM that makes part ''A'' and also calls part ''A'' as the main material. 

In DD on the SQL tab enter the following script to identify the bom causing the problem: 

select s.mfgno, p.arinvt_id 

from standard s, partno p 

where s.id = p.standard_id 

and s.arinvt_id_mat = p.arinvt_id 

2.  A BOM that makes part ''A'' and part ''B'' where part ''B'' calls part ''A'' as a component. 

In DD on the SQL tab enter the following script to identify the bom causing the problem: 

Select * from wo_depend 

where work order_id = parent_work order_id 

Run each one of these sql statements and the one that comes up with data is the scenario that is causing 
the problem. It will surface the standard_id for the BOM. Go to the Standard table to get the Mfg# and 
then go to that Mfg # in the BOM module and make changes as necessary. 

Existing Locks 

Occasionally the system will prevent a user from running Update Schedule because the system cannot 
acquire an exclusive lock. There are several possibilities that may cause this, such as: 

1. Two users log in to EIQ, both users go to Scheduling, both users go to File -> update schedule -> User A 
starts the MRP Engine and then user B attempts to do the same -> Failed to acquire exclusive lock 
because somebody else (User A) is using scheduling module. 

2. Two users log in to EIQ, both users go to Scheduling, user A goes to File -> update schedule and starts 
the MRP Engine -> user B right clicks to insert job from scheduling pool -> Failed to acquire shared lock. 
Update schedule process initiated by User A' is currently in progress. 
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3. Two users log in to EIQ, User A to Scheduling and starts the MRP Engine, user B attempts to launch the 
scheduling module -> same warning as #2. 

4. Two Users log into EIQ, User A Opens scheduling and then opens the Find Work Centers Pick List, User 
B goes into the scheduling module and attempts to start the MRP Engine -> Same as warning #1 

When this happens the user can select Existing Locks from the Troubleshooting menu to display the 
name of the workstation causing the lock, the Lock Handle, and Module. 

 

 
 

Change Log 

From the MRP Engine users also have access to the Change Log. From the File menu select Change Log. 
The Event Log screen will appear set to view the Net Change Log. 
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This log lists dates and associated net change information. This is the same Event Log form that is 
accessible from the EIQ Launcher bar under File->System->Event Log. 

Other Event Logs related to Update Schedule 

All logs are accessible from the Event Log. Three that are related to Update Schedule are: 

▪ IRV32 INFO log - This log details when and who ran update schedule and the default scheduling scope 
used. 

▪ IRV32 WARNING Log - This log details any warnings related to the MRP Engine such as Actual Cavity = 
0. Please verify BOM configuration. 

▪ AUTO-LOAD - This log details work orders that could not be scheduled through the auto load process. 

Select the desired Event Log Class from the drop down list and select the desired date range from the 
drop down calendars. Once selected press Apply and all information within the entered time frame for 
the selected log will appear. 
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Firm Work Orders 

A firm work order provides a bridge between a manual work order and a system generated work order.  
Manual work orders are used to handle situations where demand is not present, but planning wants to 
build inventory for stock or other purposes. Manual work orders do not change when the system re-
evaluates supply and demand. System generated work orders are entirely dependent on supply and 
demand and are subject to change based on changes in supply and demand. Firm work orders allow the 
quantity to produce to be modified and locks in the quantity to produce until manually adjusted. 

An example of how a firm work order functions within EnterpriseIQ follows: 

Assume a sales order exists for 5000 parts of product XYZ. Without any inventory on the floor, 
EnterpriseIQ will generate a work order for the full 5000 pieces. 

Management determines that they would prefer to manufacture 7000 pieces for whatever reason. The 
operator then goes to the Work Order module, finds the new work order, and does two things. First, the 
check box is set to turn the work order into a firm work order. Second, the quantity is adjusted to 7000 
pieces. Note the bucket number is cleared. Firm work orders do not contain a bucket number as it is no 
longer part of the generated work order mechanism. The requirements for the firm work order are no 
longer associated with the sales order demand. By marking a work order firm you are telling the system 
to not adjust the quantity based on changes in demand. 

Date and Quantity changes 

Quantity Change Example: 

Using the above example, now assume a second release for the same item is entered into EnterpriseIQ. 
This release requires an additional 5000 pieces. Total demand at that moment (assuming no production 
has occurred yet) is 10000 pieces. When update schedule completes its evaluation, it will create a 
second work order for 3000 pieces. This occurs because update schedule understands that a work order 
already exists to cover the first 7000 pieces of the total 10000 piece requirement. This work order will 
contain a bucket number of one, since it is still the “first” generated work order in the system that covers 
demand for this item. 

Inventory found on the floor during the update schedule procedure is taken into account as part of the 
supply, and is allocated against the total demand. 

Promise Date Change: 
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If the Promise Date changes to an earlier date on the sales order the system will adjust the must start 
date on the firm work order automatically. The system will not create a planned work order unless the 
firm work orders do not satisfy all of the demand. Essentially the Firm work order is linked to the 
demand it is satisfying and if date adjustments are made to that demand for an earlier date the work 
order will adjust also. If a new sales order is added with a promise date earlier than the original demand, 
the Firm work order will now cover this demand, and an additional work order will be created to cover 
the remaining demand from the first sales order, and any remaining demand of the new sales order. 
Note that the Firm work order will retain the reference to the original sales order demand indicating why 
it was created. This applies to scheduled and unscheduled firm work orders. If the promise date changes 
to a later date the must start date of the firm work order does not change. 

Creating Firm Work Orders 

Firm work orders usually start out as generated work orders, though they can be created manually. Once 
the work order is generated, the quantity to produce can be modified. To do this click on the Firm flag 
under the work order number on the work order form. Once this box is checked or unchecked a mouse 
over hint will display that shows 'Checked by: UserID on Date/Time' or 'Unchecked by: UserID on 
Date/Time'. (Work orders marked Firm prior to this system change will not have the mouse over hint). 
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Note: If the Firm check box is cleared at a later date, the work order becomes a manual work order, and 
the normal manual work order rules would apply. If you no longer want the work order marked firm you 
must delete it and re-run update schedule to properly re-evaluate the need for the item(s). If the Firm 
box is unchecked the user will receive a confirm message stating, "Unfirming this Work Order will 
transform it into a Manual Work Order which must then be manually deleted from the system. Demand 
is NOT allocated to Manual Work Orders. Are you sure you want to continue?" 

Note: If a user attempts to mark a work order firm while update schedule is running a confirm message 
will appear stating: 'Update schedule is currently running. Firming this planned work order while the 
MRP engine is processing can affect allocation and generate duplicate demand. Proceed?' The message 
has a Yes and No button. If the user selects Yes the work order will be marked firm, selecting No will not 
mark it firm. 

Cascade Firm to Dependent Work Orders 

An option is available in the scheduling parameters (Schedule/Options/Scheduling Parameters) to firm 
dependent work orders when a main work order is marked firm. With this option on all dependent 
demand work orders are marked firm automatically when the main work order is made firm. 

NOTE: If you have the option to Cascade Firm to Dependent set and you un-check the firm box on the 
main work order the dependent work orders are not automatically set back to a non firm work order. 
You must manually go in and un-check the Firm box on the dependent work orders. 

Reasons a Work Order is Marked Firm by the System 

The system will mark a work order Firm if one of the following applies: 

▪ When a work order for an item that has a Mfg Min quantity is put into the first position on the finite 
schedule, if the system has rounded the work order to the Mfg min 

▪ When a work order with a Mfg Multiples Of is put into position one on the finite schedule, if the 
system has rounded the work order to the Mfg multiples of 

▪ Auto-MRP is setup to firm ('Make FIRM WO' check box is checked in Auto MRP settings in Inventory) 

▪ Default Planning Fence is set (BOM Miscellaneous Parameters->Scheduling tab) 

▪ 'Mark work order FIRM on setup' is checked in Scheduling Parameters 

▪ A work order is loaded into Assembly Track 

▪ Outsource central work orders are marked firm when the components are shipped 

▪ Work orders that were system modified based on the MFG Min Quantity will be marked firm when 
Production Reporting by Work Order is used to report production 

▪ Work Orders added to a Group ID (Finite Scheduling->Options->Group ID Assignments) 

Dispositions and Firm Work Orders 
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Like system generated work orders, but unlike manual work orders, the quantity to produce on a firm 
work order will be adjusted as dispositions are completed and update schedule is run again. Shipping 
product with a firm work order outstanding does not decrement the amount on the order. Use the 
production reporting module or IQRF to create dispositions, then run update schedule, which will reduce 
the “quantity to go” value. 

NOTE: If Negative floor dispositions are used to correct over reporting of parts, they are not considered 
in the parts to go value. After running update schedule the parts to go does not increase. The user can 
manually increase the work order quantity if desired. 
 

Troubleshooting Work Orders 

When generated work orders do not appear to match reality, check the following: 

▪ Sales Orders - Are the sales orders accurate? Are there old orders that still exist in the system? Are 
the release dates and quantities accurate? Check the sales orders linked to each work order and 
double check them for accuracy. 

▪ Inventory - Is the on hand inventory accurate? Consider taking a physical count of those parts 
included in work orders and updating the master inventory file. Then re-run the update process and 
check for work order accuracy. 

▪ Manual Work Orders - have work orders been created manually that might fulfill a sales demand? 
Technically, this would not change the way the work order is generated, but it can cause confusion 
when scheduling. It might appear that two work orders are in the scheduling pool to fulfill the same 
demand. 

▪ Purchase Order - If a manufactured item is added to a purchase order with a delivery date that will 
meet the demand for the item, the work order will be removed after updating the schedule. 
However, in the case of an Outsource manufactured item the work does not get removed. The 
system recognizes that it is an outsource item and does not remove the work order. 

White Work Orders - Work orders that appear completely white (with a must start date for year 1899) 
have no requirements since the last time update schedule was run. (No requirements may be due to a 
number of reasons such as a change to the sales order or ‘on hand’ inventory). The Origin of the work 
order will remain to help troubleshoot why there is no longer any demand. If these work orders are 
removed from the schedule they will not be put into the scheduling pool because there is no longer any 
demand for the item. These work orders should not be changed as they are just place holders. If there 
are still requirements for the item users should create a new work order, mark it firm, and schedule it. 
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RT Work Order History 

Select the RT Work Order History button  to display the RealTime™ work order history for the 
specific work order. This will show past RealTime™ information for the specific work order if it has been 
taken out of first position. Each time it is put into first position and then taken out of first position a 
record will be added.  

The ‘From Date’ defaults to the Current Date – 30 days, and the ‘To Date’ is the current date. To enter a 
different date range select a date from the drop down calendar in the From Date and To Date fields on 
the left side of the form. Then select the Apply Selection Criteria button to populate the table with the 
work order history for the desired date range. 

 

The user can view information regarding the work order for the specified date range that includes: total 
up hours, total cycles, total down hours, average cycle, work order quantity, total floor dispositioned 
quantity, FG lot number, priority notes, and many more. 

The RealTime Histogram can be accessed from this module by right clicking on the record you would like 
to view and selecting 'RT Histogram'. Please see RealTime Histogram for more information. 
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Delete or Archive Work Orders 

Work Orders can be deleted or archived. From any where in the system a work order can be deleted the 
system will pop up a screen asking the user if it should be deleted or archived. 
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Selecting Delete will remove the work order from the system. 

Note: If the work order is scheduled it cannot be deleted. An integrity constraint error will appear. 
However, from the Production Reporting by Work Order module (PRW), if the work is marked Firm and 
the user checks the 'WO Completed' option, the work order will be deleted even if it is scheduled. 

If Archive and Delete is selected the work order information is written to the Hist_Workorder table.   

The selection is remembered in the registry. 

Note: If a user attempts to Delete or Archive and Delete a Firm work order while update scheduled is 
running a confirm message will display stating, "Update schedule is currently running. Are you sure you 
want to delete this Work Order?', with Yes and No buttons, and the 'Do not show next time' check box. 
(Security is available on this message form). If the user selects Yes, the firm work order will  be deleted. 
If No is selected, a warning will appear stating, "Failed to acquire shared lock. "Update Schedule" process 
is currently in progress. Please try again later." 

Deleting ASSY Work Orders  

If a user attempts to delete an ASSY work order and it is in Assembly Track an Authorization required 
status exception will appear stating that the work order is in Assembly Track. Select OK to continue 
deleting the work order which will also remove it from Assembly Track; or select Cancel to not delete the 
work order. Security can be put on the OK button to prevent users from deleting ASSY work orders that 
are in Assembly Track. 

When the user tries to delete an ASSY1 or ASSY2 workforce (through Assembly Track or the work order 
module) the system will check the translog to verify if PIT is posted. (Note: the option 'Use Standard Cost 
during Post Transactions' must be checked in System Parameters, Inventory Setup tab). If some records 
have not been posted, an exception error will be raised. The user can override the exception to go ahead 
and delete the work order. Security can be setup on this exception error. 

When the system tries to auto-remove firm work orders, the system will run the same check. Even if 
some records have not been posted, the system will remove and delete the work order. NOTE: This is 
also true for substitute BOMs. If unposted transactions still exist, the system will delete the work order, 
however, the substitute BOM will not be deleted. After posting the PIT transactions, it is recommended 
to then delete the substitute BOM. 

View Archived Work Order  

Archived work orders can be viewed from Work Order>File>View Archived Work Orders, or via the drop 
down menu item 'Search Archived Work Orders' on the binoculars icon on the work order form.  
Archived work orders are read only when viewing them.  
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Note: Work orders in RealTime™ that are completed (zero parts to go or less) and removed from first 
position can be archived. The same pop up box will display to chose delete or archive. 

Note: Work orders that are deleted by Update Schedule are not archived. 
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